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1. Foreword 
 
WI LINE is a range of high-quality digital protection devices for medium-voltage applications. The 
devices in WI LINE combine all of the advantages that modern digital technology has to offer. As 
primary protection, “WI LINE” meets the highest demands that can be made of modern, digital sec-
ondary technology. 
 
“WI LINE” does not just support the user with a wide range of easily selectable protection functions. 
The optimised design and the implementation of many functions in one device result in potential 
cost reductions in the planning, materials and installation areas. As well as consistent use of digital 
technology, the system philosophy focuses on good availability, self-monitoring, flexibility and an 
ergonomically designed user interface. 
 
Because of their robust design, the protection relays of WI LINE can be directly installed in the 
switching system, meaning that the amount of wiring is reduced to a minimum. 
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2. Usage area of WI-Soft2 
 
“WI-SOFT2” provides easy, menu-controlled parameterisation and evaluation of WIC1 and WIB1 
relays. “WI-SOFT” makes consistent use of the options provided by digital protection technology, 
such as communication and data backup facilities. The Windows-oriented user interface means 
that the user is intuitively familiarised with the main functions of the program, whereby plausibility 
checks and password checks provide maximum security at all times. “WI-SOFT2” also makes it 
possible to plan and parameterise the device in offline mode for working in the office. 
 

 
 

Figure 2.1: System – Example parameters 

 
 
“WI-SOFT2” makes the following possible: 
 
• easier and quicker handling of the WIC1 and WIB1 protection relays, 
• user-friendly help functions, 
• easy operation due to the familiar Windows interface/window technology, 
• convenient backing up of data on various storage media, 
• printing functions, 
• good documentation options by means of printing and 
• central use as an analysis and parameterisation tool. 
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3. Installation/Uninstallation 
 

3.1 Hardware and software prerequisites 
 
“WI-SOFT2” will run on any IBM-compatible PC Windows 2000/XP/Vista/7 operating systems. 
Communication takes place via the RS232* or USB** interface. The program can be operated us-
ing the mouse (Windows standard/Windows interface) and has user-friendly window dis-
plays/technology. “WI-SOFT” is simple to install, and is available in the German and English lan-
guages. 
These instructions relate to software version 1.3. 
 
 

3.2 Installing WIC1-Soft 
 
The WI-SOFT2 installation program is started using Windows Explorer by means of double-
clicking. 
 

 
 

Figure 3.1: WI-Soft2 installation 

Please comply with the instructions and questions in the installation menu. 

The actual installation is started by means of another mouse click, and all of the files that are re-
quired are copied into your target directories. (WI-SOFT2 is now ready for operation) 
 
 
 
 
 
 
* Communication via the RS232 interface with the WIC1 PC2 adapter. 
** Communication via the USB interface with the WIC1 PC3 adapter.  
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3.3 Uninstallation 
 

3.3.1 Option – uninstallation via the Start menu 
 
The uninstallation of “WI-SOFT2” is started by clicking with the left mouse button on 
Start/Programs/Woodward SEG/WI-Soft2/Uninstall WI-Soft2. The “Automatic uninstallation” per-
forms a full uninstallation of "WI-SOFT2".  
 
 

3.3.2 Option – uninstallation via the control panel 
 
The uninstallation is started using “Start/Settings/Control Panel/Add or Remove Programs”. 
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4. Required configuration 
 
The communication between the PC/Laptop and the WIC1/WIB1 takes place via USB or a serial 
cable depending on the PC adapter that is used. 
 
After WI-Soft2 has been installed, it must be configured and/or several parameters must be set. To 
do this, proceed as described in the following chapters. 
 
 

4.1 Configuring the SEG_Communication_Dispatcher 
 
The SEG Communication Dispatcher is called up using “Start/Programs/Woodward SEG/WI-Soft2”. 
 

Click on button 
“Client info” 

1 

 
 
 
 

Click on „Default 
Mapping“ with left 

mouse button 

2 

Drag text “Default Mapping” to 
the “WIC Serial” icon holding 

mouse button down 

3 
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4.2 Configuring the SEG_Serial_Server 
 
Call up the SEG_Serial_Server using “Start/Programs/Woodward SEG/WI-Soft2”. Select the COM 
interface to which you have attached the PC adapter. If a USB adapter such as the WIC-PC3 is be-
ing used, this is shown as an additional COM interface. 
 
 

Selecting the serial 
interface (COM port)

1 
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5. Starting the program/establishing a connection 
 

5.1 Starting the program – communication via PC adapter 
 
The following steps must be performed in the specified order to make the program run properly. 
 
1. The WIC/WIB relay must be connected to the PC/Laptop via the PC adapter using the provided 

USB (or serial) cable. 
2. WI-Soft2 is started using “Start/Programs/Woodward SEG/WI-Soft2”. WI-Soft2 then loads the 

SEG_Communication_Dispatcher and the SEG_Serial_Server automatically. 
 
 

 

Important information about a known error (WI-Soft2 Release 1.3): 
 
At the point in time when this document was produced, an error occa-
sionally occurred when the connection was being established as de-
scribed in this section. The error manifests itself in that the 
SEG_Serial_Server is not loaded automatically. In order to avoid this 
problem we recommend starting the WIC-Serial Server first as de-
scribed in section 4.2, preparing it using "Connect" and then establish-
ing the connection as described in the following paragraph. 

 
 
3. An active connection to the protection relay is created using the following icon. 

 
 
The active connection is indicated by the appearance of the menu tree and the inverted display of 
the icon shown above. If no relay can be found at the configured COM port, an error message ap-
pears. 
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5.2 Stopping the program – communication via PC adapter 
 
To stop the program, perform the following steps in the specified order. 
 
1. Stop the active connection to the relay using the following icon. 

 
 
2. Terminate WI-Soft2 using “File – Exit”. 
3. The SEG_Serial_Server must then be called up via the status bar. 
 
 

Double click on this icon 
maximises 

SEG_Serial_Server 

1 

 
 
The connection to the relay is disconnected using the "Disconnect" button. The SEG_Serial_Server 
is exited by clicking on the “Exit” button. 
 
4. The SEG_Communication_Dispatcher is maximised using the following icon in the status bar. 
 
 

Double click on this icon 
maximises 

SEG_Comm_Dispatcher 

1 

 
 
The “SEG_Communication_Dispatcher” is now also exited using the “Exit” button. 
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6. Menu structure 
 
The user interface consists of five areas. 
 
• Menu bar 
• Button bar 
• Tree structure 
• Work area 
• Status bar 
 
Double clicking on individual branches within the tree structure causes the relevant window to open 
up in the work area. Several windows can be open at the same time. These can be arranged in ac-
cordance with requirements using the “Window” menu. Any open window can be made the “active 
working window” by clicking on the relevant window. 
 
 
  Menu bar 

Tree structure Status bar Work area 

Button bar 
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6.1 The button bar 
 

The button bar provides quick and easy access to the most important functions of WI-Soft2 using 
the mouse. 
 
The button bar operates interactively. If a function is available in the current mode, the icon is dis-
played in colour. If a function is not available in the current mode, the icon is greyed out. This 
makes everyday working with WI-Soft2 much easier. 
 

 
 
The button bar provides visual indication of two mode variants. These are: 
Online mode blue Offline mode yellow 
 
The individual buttons and their functions are explained in the following. A detailed description of 
the individual functions can be found in chapter 8ff. 
 

 Activate connection to relay (activate online mode) 

 Deactivate connection to relay (deactivate online mode) 

 Store active parameter set on relay (only in online mode) 

 Store active parameter set on hard drive (only in online mode) 

 Load a parameter set from the hard drive and stores it on the relay (online mode) 

 Generate a new parameter set (offline mode) 

 Open a parameter set from the hard drive (offline mode) 

 Store active offline parameter set on hard drive (offline mode) 

  Close open PC parameter window (offline mode) 

  Remove PC parameter entries from work area (offline mode) 

  Print current document 

 Print selected parameters  
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 Password entry for the I>> protection level of the relay, enables the I>> parame-
ters. 

 Print selected parameter set 

 Help for WI-Soft2 
 
 

6.2 The menu bar 
 
The menu bar allows the user to make basic WI-Soft2 settings. The individual menus and their 
functions are explained in the following. 
 
 

6.2.1 File menu 
 

 
 

6.2.1.1 Printer settings 
 
The “Printer Settings” function opens the standard Windows menu for selecting printers and enter-
ing printer settings. The usual settings can be made here. 
 
 

6.2.1.2 Last open 
 
The last parameter sets to be opened are displayed here. This gives the user an easy way of re-
trieving the last parameter set to be edited. 
 
  



Woodward Manual WIB1 EN  

14 TD_WI-Soft2_11.10_EN_Rev.New 

6.2.1.3 Settings 
 
The basic settings for WI-Soft2 are made under this menu item. 
 

 
 
It is possible to protect the saving of a parameter on a relay using this password. The default set-
ting by SEG is no password. If you wish to protect saving, enter a password in the dialogue win-
dow. If you wish to change the password, the old password has to be entered first as confirmation. 
 

 
 
By way of additional protection, WI-Soft2 makes it possible to protect the short-circuit stage I>> 
separately. The factory settings can only be changed by entering the separate password for the I>> 
stage. The SEG factory setting for this password is “SEG”. 
 

 
 
This function is used to define the default working directory in which WI-Soft2 stores the parameter 
sets on the hard disk and from which the parameter sets are read. 
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Language 
 

 
 
The user language for WI-Soft2 is defined using this menu item. At the moment, 
• German and 
• English 
are available. Other languages are being prepared. Because of the Open Source structure of WI-
Soft2, additional languages can be added at any time. Please contact your responsible sales part-
ner on site if necessary. 
 
The language that is required is selected by highlighting it with the mouse and confirming with the 
“OK” button. Then WI-Soft2 must be exited and restarted so that the user language can be 
changed. 
 
 

6.2.1.4 Exiting 
 
WI-Soft2 is exited using the “Exit" function. The auxiliary communication tools must be exited sepa-
rately as described above. 
 
 

6.2.1.5 “View” menu 
 

 
 
Display screen areas can be displayed and removed using the functions in the “View” menu. 
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6.2.1.6 “Window” menu 
 

 
 
The functions in the “Window” menu make it easier to handle the opened windows in the working 
area. 
  

6.2.1.7 “Help” menu 
 
 
Version information about WI-Soft2 can be found under the Help menu. 
 

 
 
 
The latest documentation and software updates can be found on the Internet at: 
 
http://search.woodward.com/wi 
 
• Data sheet for the WIC1 PC3 adapter 
• WI-Line product specifications 
• WI-Line device descriptions 
• USB driver 
• WI-Soft2 
• WIC1-Soft 
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7. Parameterisation 
 

7.1 Editing a parameter set 
 
The editing of a parameter set is independent of the mode that WI-Soft2 is currently in. Editing can 
be carried out directly with the WIC1 or WIB1 relay online, or indirectly in offline mode. 
 
Additional note:  
The WIC1 and WIB1 devices can only parameterised on device variants without DIP/HEX 
switches. These are device variants with order code:  
WIC11xx or WIB11xx. At the point in time when this document was created, version1.3 of the WI-
Soft2 software was the current release. 
 Only parameter sets for WIC1xx protection relays can be created and edited with this release. The 
basic differences are noted in the rest of the description. With the device variants with order code 
WIC12xx, WIC13xx and WIB12xx, the parameters can only be read out of the device. 
 
The basic steps are explained in the following: 
 
1 The parameter set is opened by double clicking in the directory tree. 
 

 
 
 
2 The parameters are opened in the window of the parameter set window by double clicking. 
 

  
 
Parameter set of the WIC1 devices   Parameter set of the WIB1 devices 
  



Woodward Manual WIB1 EN  

18 TD_WI-Soft2_11.10_EN_Rev.New 

2.1 Setting the rated current/selecting the converter ratio. The rated current of the protection ob-
ject is the starting point for all other relative protection parameters. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.2 Selecting the protection characteristic 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Selecting the con-
verter ratio 

Adjusting the rated current 
of the projected object 

WIC1 WIB1 

Protection characteristic 
selection 

WIC11 WIB11 
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2.3 Selecting the overcurrent excitation factor I> 
 
The excitation factor I> can be set variably within the adjusting range. The excitation factors are not 
stored in the protection relay as graduated values. The step width depends on the absolute setting. 
After entry, WI-Soft2 automatically rounds to next permitted value. 
The overcurrent stage I> can be deactivated by selecting it. This means that the WIC1 relay can be 
as short-circuit protection only. 
 

 
 
 
2.4 Setting tripping delay tl> and time multiplicator factor a for the overcurrent stage. 
 
Depending on the selected protection characteristic, the tripping delay tl> is set with this parameter 
with an independent characteristic (UMZ). With a dependent characteristic (AMZ) “Factor a” is set 
for the time multiplicator. Parameter values are stored in stages in the protection relay. The step 
width depends on the absolute setting. After entry, WI-Soft2 automatically rounds to next permitted 
value. 
 

 
 
 
Factor a setting for AMZ protection 
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2.5 Setting the short-circuit excitation value I>>  
 
The excitation value I>> for the short-circuit stage can only be modified if the correct password has 
been entered beforehand. If the values for I>> have a grey background, setting the I>> value is not 

permitted. Please close the parameter set window and click on the Password button  to 
open the dialogue window for parameter entry. 
 

 
 
After successfully entering the password, open the parameter set window again by double clicking 
on the parameter set in the directory tree. Now the parameters for the short-circuit stage no longer 
have a grey background, and entries are permitted. 
The short-circuit stage I>> can be deactivated by selecting it. This makes it possible for the user to 
protect the entire current range by means of the dependent characteristic curve with AMZ protec-
tion characteristics. 
The excitation factors are not stored in stages in the protection relay. The step width depends on 
the absolute setting. After entry, WI-Soft2 automatically rounds to next permitted value. 
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2.6 Entering the tripping delay tI>> for the short-circuit stage 
 
Parameter values are stored in stages in the protection relay. The step width depends on the abso-
lute setting. After entry, WI-Soft2 automatically rounds to next permitted value. 
 

 
 
 
2.7 Setting the excitation value IE> for earth current protection 
 
The earth current measurement protection function can be deactivated by selecting it. Relay WIC1 
then only operates in phase current protection without the earth current measurement. The earth 
current protection is designed as single-stage UMZ protection. 
The excitation factors are not stored in stages in the protection relay. The step width depends on 
the absolute setting. After entry, WI-Soft2 automatically rounds to next permitted value. 
 

 
 
 
2.8 Entering the tripping delay tIE>> for the earth current stage 
 
Parameter values are stored in stages in the protection relay. The step width depends on the abso-
lute setting. After entry, WI-Soft2 automatically rounds to next permitted value. 
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3. Saving the parameter set 
 
The modified parameter set can now be saved. The following storage variants are available de-
pending on the mode. 
 
Online mode 

 The parameter set is stored on the WIC1 relay with this button. 
 
Offline mode 

 The parameter set is stored on the hard drive with this button. The typical Windows dia-
logue window for entering a name and selecting the directory appears. 
 
If the parameter set window is closed using the close icon at the top right, you are asked whether 
you wish to save the parameter set or whether the changes are to be discarded. If the changes are 
to be saved, they are automatically saved on the source that has been called up. 
 
 

7.2 Parameterising a WIC1 (online mode) 
 

7.2.1 Opening/loading the parameter set from the WIC1 
 
After successfully establishing a connection between a PC/laptop and the WIC 1 relay, the WIC1 
with parameter set and fault memory is displayed in the directory tree. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Double click to 
open parameter set 
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7.2.2 Storing the parameter set on the hard drive 
 
If the parameter set has been modified, it can now be saved on the hard drive for documentation 
purposes. 
This is done by activating the dialogue for storing the parameter set on the hard drive by clicking on 

the Save icon . The following typical Windows dialogue window opens. 
 
 
 
 

7.2.3 Saving the parameter set on the WIC1 
 
To save the WIC1 parameter set again after making a change, all you need to do is click on the 

Online Save icon . The values are written to the WIC1 relay and read back with a check-
sum. 
 
 

7.2.4 Loading a parameter set and saving on the WIC1 relay 
 
If you would like to transfer a parameter set that has been edited offline directly from the hard drive 

to the WIC1 rely, all you need to do is click on the Online icon . This opens the following 
dialogue window for selecting a parameter file from the hard drive. The parameter set is copied 
from the hard drive to the WIC1 by clicking on the “Open” button. 
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7.3 Parameterising with a parameter set (offline mode) 
 

7.3.1 Creating a parameter set for offline editing 
 

To create a parameter set without a WIC1 relay connected, click on the Offline Icon . This 
opens a new parameter set in the directory tree. The new dialogue window for selecting the WIC1 
relay type is opened by double clicking on the “New Parameter” directory. The selection is re-
stricted to relay types with and without earth current. After selecting the relay type and confirming 
with “OK”, the new parameter set is displayed in the work area. 
 

 
 
 

7.3.2 Opening a parameter set from the hard drive for offline editing 
 

To open a parameter set from the hard drive, click on the Offline icon . This opens a typical 
Windows dialogue window for selecting a parameter file. After selecting a file, it is displayed below 
the “PC Parameters” item in the directory tree together with its name and storage location. 
 

 
 
 

7.3.3 Storing the active parameter set on the hard drive 
 

If you wish to save the parameter set that has been edited offline, click on the Offline icon  
with the parameter set window open. It opens the menu window for selecting the target directory 
and a filename in the typical Windows style. 
 
  



Manual WIB1 EN Woodward 

TD_WI-Soft2_11.10_DE_Rev.New 25 

8. Fault memory 
 
The WIC1 protection relays all have a simple but effective fault memory. This writes the measure-
ments to non-volatile memory at the moment of tripping. Only the last tripping can be saved. The 
fault memory can only be read out via the relay interface. 
 

8.1 Reading out the fault memory 
 
To read out the fault memory, perform the following steps: 
 
Double clicking in the “Tripping values” directory in the directory tree causes a window containing 
the tripping values to be opened in the working area 
 
 

 

Double click to open 
parameter set 

 
 
The binary information about the reason for the tripping is specified in the top half of the tripping 
values window. The parameter marked with logical I was the reason for the last tripping of the pro-
tection relay. In this example it was external tripping via the tripping input. 
The measurements at the moment of tripping are displayed in the bottom half. The tripping values 
are displayed as primary values depending on the selected converter ratio in the parameter set of 
relay WIC1/WIB1. 
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